
AlphaBlox OfficeBlox Reviewer’s Guide version 1.0

Introduction
The aim of this guide is to give an introduction to the AlphaBlox OfficeBlox and should enable 
a reviewer to work through each Blox, exploring its main features and starting to understand 
how the suite fits together to produce a working business solution.

Requirements
This release of the AlphaBlox OfficeBlox requires Windows 95 and a 386 or faster PC with at 
least 4 Mb of ram installed. This installation guide was written and tested with the release 
version of Windows 95. Reviewers encountering problems may want to check they have, in 
the first instance the final version of Windows 95 and should then contact their local support 
office.

Installation
To install AlphaBlox OfficeBlox, place the first install disk in the floppy disk drive of your 

computer, and from within Windows 95 click on the Start button (  ) and select 
Run...

Then, enter a:\setup, e.g.:

Follow the on-screen install instructions to install AlphaBlox OfficeBlox version 1.0

AlphaBlox OfficeBlox
Having installed the Blox components onto your computer, you are now ready to begin this 
reviewer’s guide. The aim is to allow you to follow the instructions in this document to learn 
about the special features of the Blox components and at the same time gain a working 
knowledge of how to use them.

ToolBlox
The first component to look at is slightly different from the three other Blox that you will 
investigate. The ToolBlox is used as your quick access to any of the Blox. It distinguishes 
itself from usual windows’ toolbars by being able to not only launch applications but to also 
launch Blox and other OLE 2 components and offers the capability of exposing the objects in 
a “ready-to-drag” state right into your documents.
To load the ToolBlox, click on the Start button and select the Programs item and then the 
AlphaBlox OfficeBlox sub menu. From here you can click on ToolBlox to launch it.

You will be presented with:



This is the ToolBlox. You will notice seven icons from left to right. The first is used to control 
the ToolBlox properties, the next allows template selection and the next four are 
NoteBlox,ListBlox,CalcBlox and WorkBlox. We have installed the Windows 95 explorer as 
the last icon for your convenience in finding files during everyday work.

 ToolBlox Preferences
If you want to adjust the ToolBlox’s preferences, click on this icon with the left mouse button 
and you will see:

Always on top Keeps the ToolBlox above all other windows. 
Tool Tips Lets you see what programs or objects you have on the ToolBlox when the 

mouse moves over them
Auto Avoid If checked, this makes the ToolBlox avoid other windows so it does not get in 

the way. If you have a maximized window on the screen, the ToolBlox 
shrinks to fit in the caption.

Drag As Icon If this is checked, any Blox dragged from the ToolBlox is displayed as an 
icon in the document that receives it.

Other options you may like to try are Toolbar Layout to determine the orientation and also 
the icon sizes on the toolbar. Note the special Caption choice which places the toolbar at the 
very top of the screen.

The final option, The Template Folder allows you to set the path to the location of your 
templates. This will usually point to the Template folder in your Blox directory, but if you are 
on a network you can point this to a folder on your file server so that everyone can share the 
same group of templates.

Try this:
Click on OK in the preference dialog box and press the ESCAPE key. The ToolBlox should 
move to the top right of the screen and is small enough to fit in the caption of a window. 
Press ESCAPE again and it should return to its normal position and size. Use this as an easy 
way to move the ToolBlox out of your way if you have a small screen or are working on a 
maximized window.

Adding programs to the ToolBlox
It is easy to extend the ToolBlox by adding more programs that you commonly use. In this 
review guide we will be using Microsoft Word for Windows version 6 and Microsoft Excel 



version 5 as programs that can use the AlphaBlox OfficeBlox. To add one or both of these 
programs to your toolbar, try this:

1) Open explorer
2) Locate the Word or Excel directory
3) Find the Word or Excel program (.EXE) file.
4) Click and drag it to the toolbar.

You can put as many programs on the ToolBlox as you want. Here is our example for the 
reviewer’s guide.

Launching Programs
Try to launch a program from the ToolBlox. Simply move the mouse over the desired icon 
and click once. The program will load in the usual way. Try the Blox and you should note that 
they load pretty quickly and you can have lots of “instances” of each program. You can for 
example open five or ten lists without any problem. You may be interested to know that the 
objects are 200 to 300 kilobytes in size, about 5-10 % the size of most desktop applications.

Creating Blox
Finally, we shall use the toolbar for one of its main features - dragging Blox or other OLE 
objects into containers. However, to achieve this we need a Blox - which leads us straight 
into NoteBlox

NoteBlox
NoteBlox was created as an easy way to create object linkable and embeddable notes into 
any OLE 2 compliant document, whether it be a legal document requiring annotations, an 
amendment to an Email or Electronic image, or a note on the Windows 95 desktop.
Notes have title,time and author tracking and can contain other Blox (In fact all the Blox in 
AlphaBlox OfficeBlox can contain other objects - they act as both OLE 2 Servers and 
Containers).
Because NoteBlox are “proper” objects, placing a NoteBlox inside a document places it and 
its contents directly into that document which means if it is sent to anyone, the reader can 
still view the contents because the NoteBlox has its data “embedded” along with the text of 
the document.



NoteBlox can also be sent via mail and there are templates to help speed up the creation of 
commonly used NoteBlox.

Try this
Suppose you want to take a phone message. This is one of the simple ways in which 
NoteBlox can benefit you.
Ensure the ToolBlox is loaded and click AND drag a note from the ToolBlox and drop it on to 
the Windows 95 desktop in a clear space. It should create a scrap looking like this:

Now, double click on that scrap and you should see...

One thing to note before we continue is that there are four icons in the middle of the toolbar 
that are consistent within each object:

(The last two icons, Drag to link and Drag to embed will be explained during the course of the 
review).

This is NoteBlox. Now, remembering that we want to take a phone memo, click on the select 
template icon and select the Phone Message Template which is in the general tab. Your note 
should now look like:



You can type in the phone call details and when finished, you can close the note by clicking 
on the close window button (X).
Note: you don't need to specify a filename! The note is dropped into the desktop as an 
object, primarily called scrap but you can change that in the usual way. Also note that once 
you have finished with this NoteBlox, you can just drag it onto the recycle bin and it’s gone!

Tracking NoteBlox
Suppose you are annotating a document with a NoteBlox and you want an easy route back 
to that document via the annotation. This is easy with NoteBlox because it fully supports OLE 
2 linking and integrates seamlessly with the Windows 95 desktop.
Try this
Load Microsoft Word for Windows and Open a file called legal.doc which is located in your 
\blox\samples directory. Once the file is loaded, drag a NoteBlox from the ToolBlox into the 
document at a position of your choice. Double click on the NoteBlox and enter some text that 
says “the offer is extended until the end of July”. Once you have finished, click off the 
NoteBlox and you return to Word for Windows.

Note: you may have noticed that when you double clicked on the NoteBlox, the menus and 
toolbar on Word for Windows changed. That’s because NoteBlox is an OLE 2 object and it 
supports “In-place” editing. You can use all the functionality of NoteBlox, but you are still 
working on your document and do not have to leave it to go to another application.

Now, supposing we want to put that annotation somewhere because we want to keep track 
of that document. Why not put it on the Windows 95 desktop ?
Try this:
Click the RIGHT mouse button on the NoteBlox and select COPY.
Then, move to the Windows 95 desktop and press the RIGHT mouse button again. Once the 
popup menu appears, select Paste Shortcut. You should now see a scrap that is linked to the 
word document.
Now, move back to Microsoft word and close it down. Make sure you save the changes to 
the legal.doc file otherwise there will be no NoteBlox to link back to!
Whenever you want to review the document that this NoteBlox is linked to, you can just 
double click on the scrap document on the desktop and you should see your legal.doc file 
load up.Try it now. This is great for tracking documents, or even reminding you of places in 
the document that you need to go directly to.

Note: Once the document is loaded, you are placed at the point where the NoteBlox was 
inserted.

Containers and Servers



As mentioned earlier, all objects in the AlphaBlox OfficeBlox suite are OLE 2 containers and 
servers (they can be placed in documents and you can place objects in them). To illustrate 
this point, double click on the NoteBlox annotation in the legal document that you have just 
reloaded. Suppose we want to add a spreadsheet to this note containing some proposal 
costings for the client. We can simply place the spreadsheet in the note because the note is 
capable of holding objects - it’s an OLE 2 container.

Try this:
Once you have activated the note, move to the toolbar and drag an Excel spreadsheet off 
right into the NoteBlox. You should now see in the note an empty Excel spreadsheet. So, 
double click on the spreadsheet to activate it.
Note: the Excel spreadsheet loads in an Excel application window. That’s because you can’t 
in-place edit an object that is already in an object that is being edited. Here, NoteBlox is 
being edited inside Word, so the spreadsheet is launched out of place.

Place a few figures in the spreadsheet and when you have finished, close it down. The 
NoteBlox may look something like:

Content vs Iconic display
In the NoteBlox you may notice that you can actually see the spreadsheet’s contents. This is 
because the object is shown in-place. However in some circumstances you may not want 
objects embedded inside NoteBlox to take up too much space. Thus, you may want to 
display them as icons.
Try this:
Click the right mouse button once on the spreadsheet object. From the popup menu, select 
Display as Icon (it should at the moment be Display Content). The object should change to 
an icon and will take up less space.
Note: If you want to drag objects from the ToolBlox as icons, either set the ToolBlox 
preferences to be “drag as icon”, or simply press the SHIFT key before you drag the 
NoteBlox off the ToolBlox.
Note also: Any object that is drawn as an icon in a document will always launch out of place. 
This is a standard OLE 2 feature.

Dragging to create embedded and linked NoteBlox.
Try this:
Launch Microsoft Excel from the ToolBlox and open up the SDEMO.XLS spreadsheet from 
the \blox\samples directory.

Now, click on NoteBlox from the ToolBlox - you should see it load up stand alone. Then, type 
into NoteBlox something like, 
“Singapore sales seem a little high, please ensure exchange rates have been applied 
properly”.

Suppose we want to put this directly into the spreadsheet. We have a bit of a problem 
because Excel is one application and NoteBlox is another. But, both support OLE 2 AND we 
have made it easy to transfer a note from stand-alone mode to full embedded object. Simply 

move to NoteBlox and click on the drag icon ( ) and drag it into Excel (note: if you do not 
have Excel 95, press CTRL as you drag). You should see the NoteBlox and its contents 



appear in Excel once you complete the drag operation. You can then close NoteBlox without 
saving the contents because it has been “embedded” right inside the Excel spreadsheet.

Note: the drag link icon ( ) works in a very similar way but is only activated once the 
NoteBlox is saved as a file. When the icon is dragged, a “link” is placed in the receiving 
document (container) which points to the file that was saved from NoteBlox. This means that 
the object in the document is very small and all the data comes from the saved file. Although 
this is a great benefit, especially if the files are saved on a network, be careful not to send the 
document to anyone who is not on your network. Why? Because all that is stored in the 
document is a link to a file, which the receiving party will not have. In this instance you should 
use the drag-embed icon to embed the whole NoteBlox into the document to be sent so that 
the receiver has access to all the data. These drag embed and drag link icons are common 
across all the Blox.

Finally, if you wanted to mail this NoteBlox to the person who created the spreadsheet to 
notify them immediately that some adjustment is needed, click on NoteBlox’s file menu and 
click on SEND. This will bring up the Mail component of Windows 95 and you can send this 
note to the relevant parties as an object.

Note: To be extend this even further, you could EDIT.COPY the note object from the 
SDEMO.XLS spreadsheet and PASTE-LINK it into your mail message. This would mean that 
when the person received the mail, they could double click on the object and actually load 
the document that the note was in and work on it straight away providing they were on the 
same network!

Other NoteBlox features to try
Try changing the colour of the NoteBlox and the font style. Select Blox.Options from the 
main menu bar and experiment.

Try creating a new template. Simply type in the text and then use FILE|Save As Template to 
store the template. Don’t be afraid to use long file names!

Use the drag icons on the toolbar to move NoteBlox around and experiment with linking. You 
can even drag shortcuts of folders into the NoteBlox from the Windows 95 desktop.

ListBlox
ListBlox allows a user to create and use many different sorts of lists and to embed and link 
them to documents that support OLE 2. The user can sort, search and filter items in lists and 
data can be dragged from one list to another or in and out of spreadsheets and word 
processor documents. ListBlox offers standard data types for the columns as well as visual 
and customisable types. The list also supports “Views” so that lists can be seen in different 
ways at the touch of a button.

Try this:
Before we explore ListBlox, try loading up a few that have already been created:
Click on the ListBlox icon on the ToolBlox and select FILE OPEN, or just press the open 
button on the toolbar.
Move to the blox\samples directory and open up the Expenses list.
Repeat the process for Address list and To do list.

As you can see it is possible to open as many ListBlox as you like. The ListBlox program is 
very small and it is only loaded once. The only extra burden you put on the system is the 
data for each additional list which is also very small. This is a common technique used 
throughout the Blox components.

Dragging ListBlox



You may want to put your expenses on the Windows 95 desktop. To do this, simply click on 
the expenses list to activate it and then drag the ListBlox onto your desktop using the Drag-

Embed icon ( ) on the toolbar.
You will see the following on your desktop:

Try double clicking on this to launch the expenses. Remember, this is a separate list now 
from the one that is in the blox\samples\expenses.lbx because it is contained within the 
desktop.

Creating a ListBlox from scratch
The next step in examining the ListBlox component is to create a new list and see some of 
the features which ListBlox gives you to help with list management. We are going to start by 
creating a commonly used list - a to-do list.
Part of the research that AlphaBlox Corporation has done shows that a lot of people use a 
spreadsheet to create and store lists. ListBlox is a far better medium for this because it is 
written specifically for lists and is small and compact. Typical spreadsheets are well over two 
megabytes in size and if several are loaded at one time, the system’s resources shrink.

Since we are wanting to start with a to-do list, we can load list from the ToolBlox with the 
desired template.
Try this:

Click the template button on the ToolBlox ( ). Then, select the “To do list - Medium” 
template from the General tab:

This will load ListBlox with the template:



Note: you can load templates for any Blox from the ToolBlox. You should find that the tabs 
sub divide templates into convenient sections.

Note also: using the template button on a toolbar within any Blox will only bring up the 
templates for that component - e.g. the template button on the list toolbar will only show 
ListBlox templates.

Filling the to do list
We are now ready to add some items to our to-do list. The first thing we want to do is add a 
new column because we may want to delegate tasks to some one. 
Try this:
Either
Select Insert Column from the Edit menu,
or
Move the mouse to the edge of the right-most column next to any of the rows numbered one 
to five and drag a new column out. You should see the mouse icon change to denote this 
before you drag.

Once the new column appears, we want to change the title and the data type of the column. 
To do this, click once on the column title and the whole column will be highlighted.
Now, press the right mouse button on the column title and you should be presented with a 
pop up list. Click on the properties option and you should see:

From here, change the caption to “Who ?” and change the data type to Pull down.



Click on OK and you will see the column title change. We have made this column a special 
type, pulldown which means that any data we add to the column will become available to 
any cell in that column.

Try this:
Double click on the first cell in the Who ? column and enter Mike. Then, enter John in the 
second row and Peter in the third. Then, double click on the fourth row and click on the down 
arrow at the end of the cell. You should see a list of all the unique entries for that column. 
You can now of course select any of the previous entries or enter a new one.

Drag and Drop into list
The next step is to put some To-do’s in! We are assuming that someone already has some 
to-dos in an Excel spreadsheet and wants to move them across.
Try this:
Load Microsoft Excel from the ToolBlox and open the file
blox\samples \todo.xls

You should see a list of to-dos. Now, position the windows on screen so you can see both of 
them and highlight all the to-dos in Excel. Then, move to the border of the highlighted area 
and drag the to-dos into ListBlox into the description column. If all goes well you should see:

The to-dos are now in your list. If you want to widen the column to fit the to-dos in, you can 

click on the resize cells button ( ) on the toolbar. You can also easily extend the window to 

fit around the list by pressing the resize list button( ).

Data Types



You may notice that the first two columns contain “traffic light” data types and that the 
Complete column contains a “Yes/No” data type. Try double clicking on cells in these 
columns to change the values. Change the to-dos to have importance and urgency and 
make a couple of the to-dos complete. The list may look like:

Sorting and Filtering
The first thing you will probably want to do with a list is to sort it. Suppose we want to see our 
most urgent tasks first.
Try this:

Click on the ascending sort arrow on the “action” bar of the list on the urgency column ( ). 
You should see the column sorted with the most urgent items first.
You may want to try this on the other columns to see its effect.

Next, suppose we want to sort by three columns. One way to do this is to go to the Format 
menu and select Data and then Sort. This will present you with a standard sort dialog box...

However, ListBlox provides an easier way to sort the data. 
Try this
To sort by Urgency ascending, Importancy descending and Complete? ascending, hold 
down the CTRL key and click on the three relevant sort arrows WHILE still holding down 
CTRL. You should notice that the sort arrows stay depressed until CTRL is released. Then, 
the sort will happen.



Filtering
Suppose we have our to-do list, and we want to delegate some items to John. This process 
involves filtering.

Try this:

Click on the filter button ( ) on the Who ? column and select John. The list should now only 
show the rows that have John as the Who?

Views
ListBlox allows you to create views on your data. A View is really a combination of a sort and 
a filter or both. In this example we want to create a view for just John’s to-dos.
So, since the list is showing only John’s to-dos because we have the filter on this, move to 
the filter bar on the list and in the Drop down list that says “View All” just type in “John’s to-
dos” and press return.

Now, if you select View All you will return to the default list. Note that there are some other 
views in here such as “Urgent” and “Complete”. That’s because this template comes with 
some predefined views which mean it is even quicker for you to filter through important data 
in your ListBlox!

Delegating
Now, we want to “delegate” John’s to-dos to his to-do list. To do this, select the “John’s to-
dos” view from the drop down list. Your list should look like:



Now, load up another list and select the “To-Do list - detailed” template. Place the lists side 
by side and then highlight the two rows in the first ListBlox by clicking on the row number 2 
and dragging to row number 4 (note:ListBlox keeps the row numbers relating to the actual 
record).
Now, move the mouse to the border of your select and you should see the mouse pointer 
change to the mouse with drag underneath it. Drag this selection and drop it in the new to-do 
list you have just created.You have now just “delegated” John’s actions into a new to-do list 
that he can use.

Objects in list
Now, along with John’s to-dos, we may want to put some documents in for him to work with. 
This is possible because ListBlox can actually store documents (OLE 2 objects) in each cell 
as well of course as all the Blox.

Try this:
Since this is John’s list (and he’s too far down the corporate ladder) he can’t delegate to any 
one. So, we will change the who column to be a “Document” column that can hold Blox and 
other OLE objects. To do this, highlight the Who column and press the right mouse button 
and select properties. In the dialog that comes up, fill it in to say:

Here, we set the data type to OLE object which means we can place objects in the list.
Now for the fun part. Click OK to clear this dialog box and then  Drag a NoteBlox from 
ToolBlox into the first cell of the documents column. Then, double click on the note and you 
can enter some information. Once you have finished, close the note and you will see it 
reflected in the list. Try dragging some other objects from the ToolBlox into the list to see 
how it handles them. 
Note: Remember - press SHIFT before you drag an object from the ToolBlox to make it 
appear as an icon.



Note: You can resize rows by clicking on the separator lines and dragging.

Other ListBlox features to try
You can import tables from databases directly into list. You must have the 32-bit version of 
ODBC installed before you can do this. From the FILE menu select Import and select a data 
source name. Then you should see the contents of the table that you chose placed in your 
list.

Try sending lists via mail. Use the FILE.Send option on the File menu.

Try creating your own templates - simply create a list and use FILE.Save As Template to 
create a new template. Remember it is available from the ToolBlox using the right mouse 
button.

Try dragging values from a SAVED CalcBlox file or other OLE 2 container into List using 
CTRL-SHIFT. This creates a live link. Change a value in CalcBlox and watch it change in list.

CalcBlox
CalcBlox provides users with an OLE 2 CalcBlox that contains a live, editable CalcSheet 
which resembles a tally roll found on some hand held CalcBlox. Predefined templates are a 
push-button away and customisable keyblox (extra CalcBlox) are available which offer easy 
creation of business templates and backsolving. The CalcSheet can be formatted and can 
have its cells linked to other CalcBlox or spreadsheets and can act as a container for other 
objects. Formulas can be created simply and all variables are referenced by their English 
name, not row or columns references.

Try this:
Click once on the CalcBlox icon in the ToolBlox and you should be presented with a standard 



CalcBlox, like this:

So, try a simple calculation. Enter the following (either from the keyboard on your computer 
or by clicking the mouse on the buttons on the actual graphical keyblox).
1000
+ 1500
+ 5000
and press the = (equals) key.
You should see 7,500.00
Now, here is where we start to see some benefit in the CalcBlox. Suppose we mis-typed and 
the first number should have been 10,000. Usually one would simply re-type the whole 
calculation. This is a nuisance, especially if we have added up many numbers. However, 
CalcBlox has a CalcSheet which is storing all our numbers behind the scenes. To see this, 
click the right mouse button on the keyblox and click on View->CalcSheet. You will now see:



The whole calculation has been stored! Of course, you can edit the values on the CalcSheet 
- try changing the first value from 1000 to 10000 and see the whole calculation update.
There is also another column available to you inside the CalcSheet. This is an interim column 
which is effectively a running total. 

Try this:
Click on the pull right arrow on the edge of the number column to view the interim column.

To unselect the column, just click on the arrow on the Interim column to close it up.

Labeling the CalcBlox
Supposing we are working on a quote for a customer, and the numbers that we have just 
entered are for the installation of a system. We can fill in the label column of the CalcBlox 
with details to remind us what each number signifies.
Try this:



Enter Software,Consultancy,Implementation and Total in the label column. The CalcBlox 
should look like:

Adding Formulas
Not only can you place values in cells but you can also place formulas. Suppose in our 
example that we want to add a Maintenance cost onto the proposal which is 10 % of the 
software value.
Try this:
Double click on the cell in the value column immediately below the 7500 value (i.e. the total 
value).
You will see the caret flashing. Click on the ‘=‘ button on the keyblox and then enter 0.1 and 
click on the * (multiply) button on the keyblox. We want to add the value of Software at this 
point. To do this, simply click on the word Software on the first row in the label column. 
Finally, press enter on the keyboard or click on any other cell. Enter a label of “Maintenance” 
on this row and you should see the value of 1000 (10 % of software) in the value cell.

Using OLE
Once someone has derived a result from a calculation, they want to place it in their 
document. However if one uses a hand held CalcBlox the history of the calculation is lost 
forever once the value has been placed in their document. For example if the quote value is 
£16,500 in this case, how can I see how this is made up once it has been placed in my 
document ?
Well, since CalcBlox is a full OLE 2 object it stores all the data associated with the 
calculation in the document - with the added benefit of being able to show just the result or 
the whole CalcSheet.

Try this:
Click on the push-pin icon on the toolbar of CalcBlox so that the pin depresses. This will 
force the CalcBlox to stay on top of all other windows. Now, load up Word for windows and 
open the file
blox\samples\proposal.doc

We want to place our proposal directly in this document. So, locate the line that begins
GBS FM System 1...



then, go to the CalcBlox and drag the CalcBlox into this line using the drag-embed icon from 

the CalcBlox toolbar ( ).

You should see the value appear in your word document. Although it looks like a number, it 
is actually an OLE 2 object.
Try this:
Double click on the value and you should see an “out-of-place” CalcBlox appear. This has all 
the values that make up that number. That’s because all the data is stored in the document. 
The CalcBlox is at the moment choosing only to show the final value. Close down the 
CalcBlox and you will return to the Word document.

Copying objects
Suppose we want to make a copy of this object in the same proposal but change some 
values. To do this we use a standard OLE 2 drag and copy method. 
Try this:
Click on the value and drag it to the GBS FM System 2 line in the document WHILE holding 
down the CTRL key. This will make a copy of the object. If you had not held down the CTRL 
key, the object would have been moved.

Now, double click on the value again and change the software value to 12000 for example.
You will see the CalcSheet update with the new value.

Formatting
The CalcSheet can be formatted. For example, click on the fourth row, next to the “Total” 
label to highlight all the cells in this row. Then move to the Format menu and select Fonts. 
When the font dialog screen appears, make the style bold and say OK. You should now see 
that the total line is highlighted.
It is also possible to format how the CalcBlox is drawn when it is in the document. At the 
moment it is displaying just the result. To change this, go to the Format menu and select 
Options. Under Embedded Display you will see that the current option is “Show Result only”. 
It is possible to show the result and the CalcBlox icon so you can easily see which values are 
CalcBlox values, but for now select the “Show CalcSheet” option.

Try this:
Close the CalcBlox and you should see it now appear in Word but it will show the CalcSheet 
containing the full calculation.

Note: double clicking on the CalcSheet will launch the CalcBlox in-place. You can then 
directly change values right inside your document. If the CalcBlox is displayed as a result or 
a result and icon, it is launched out of place.

Creating Templates
Close down Word and you should see on your Windows 95 task bar that there is a CalcBlox 
still running. That’s the original CalcBlox you did the proposal quote on before you dragged 
the contents into Word. We shall make a template out of this calculation so that anybody who 
wants to do a quote can use it in the organisation.

Try this:
Make the values of Software,Consultancy and Implementation 0. This will make the Total 
value 0 and also the Maintenance (which was 10 % of software). We can now make this into 
a template.
From the FILE menu, choose Save As Template. You can call this Maintenance Proposal.

Note: Remember you can use long filenames under Windows 95.

Now, click on the all-clear button on the CalcBlox (AC) and the CalcSheet will clear. Then, 
press the Apply Template button on the toolbar and select Maintenance Proposal. The 
calculation returns and you can enter some values. This makes it easy for end-users to share 



calculations within an organisation and allows frequently used calculations to be used with 
the minimum of effort.

Keyblox
CalcBlox also gives users another way to create calculations or to extend the reach of the 
CalcBlox in different environments. CalcBlox allows any number of keyblox to be created and 
a keyblox generator will be made available at some point so that end-users can create their 
own.

Try this:
Click on the Set Keyblox button on the toolbar and choose scientific. You should see the 
standard keyblox change to the following:

Now you have extra keys to do scientific type calculations.
However, there is another type of keyblox which will not only simplify the creation of 
calculations but will also let the user backsolve.

Try this:
Click on the set keyblox button and select the Break Even Analysis keyblox. You will see that 
this is very similar to the standard keyblox but has some extra buttons available at the 
bottom.

We can use this CalcBlox to work out a Break even analysis calculation.
So, enter 20 on the CalcBlox keyblox and press the Units sold button.
Then , enter 100 for the unit price,20 for the variable costs and 5000 for the fixed costs.
Then, press the Profit button without entering any value and the Profit line shows a value of
£-3400. However, we want to know how many units we need to sell to make a Profit of 0, i.e. 
to break even.
So, click on the -3400 and just enter 0. Then, simply click the units sold button to yield a 
value of 62.50. Hence 63 units have to be sold to break even on this venture. This ability to 
solve for any variable is called backsolving and is an integral part of the CalcBlox.

Full OLE 2 support
Because CalcBlox supports OLE 2, try dragging an NoteBlox from the toolbar into the 
CalcSheet of this calculation. When it appears, just double click on it and you can put in 
some details about this calculation for someone else to see. You can of course use all the 



other standard features of Windows 95 such as sending the CalcBlox as an attachment to a 
mail message. The CalcBlox also supports OLE 2 automation.

Linking Calculations
Again, because of the CalcBlox’s full OLE 2 support, it is possible to link CalcBlox together. 
In the following example, two depreciation CalcBlox are linked, and changes made to one 
are updated in the second.

Try this:
Load up two CalcBlox. Do a simple calculation in the first and save it as Calc1.cbx.
Now, we will use the result of the first calculation in a second calculation.

Try this:
Highlight the answer in the first CalcBlox and move the mouse to the border of the cells and 
the mouse pointer should denote a DRAG symbol. Then, drag the contents of these cells, 
WHILE holding down CTRL-SHIFT, into the corresponding cell in the second CalcBlox.

Note: holding down CTRL-SHIFT while dragging creates an OLE 2 link. CTRL on its own 
creates a copy of the object and no modifier keys will move an object that you are dragging.

So, we should now have a link between the two CalcBlox.
Try this:
Change the calculation in the first CalcBlox and you should see the result change in this and 
the second CalcBlox.

note: the first CalcBlox had to be saved because linking is only possible between files.

Other CalcBlox features to try
Try dragging cells from CalcBlox into other documents that receive text. List is a good 
example.

Try some of the templates available to you inside CalcBlox. Fill in the values and see the 
final result change.

Experiment with some of the keyblox and try backsolving out to solve for different variables.

Use Format.Options to customise different aspects of the CalcBlox.

WorkBlox
WorkBlox is the last Blox on your ToolBlox. This is not quite the same as the other Blox’s as 
it is not placed in documents. Instead, it is used as a place to store files, documents, images, 
data and of course all the Blox.
If you load up the WorkBlox, you will be presented with a Start WorkBlox. You can use the 
tabs to see various items inside the WorkBlox and you can double click on various objects to 
activate them.

You should work your way through this at your leisure, but for now we will create a new 
WorkBlox and explore some of its features.

Creating a new WorkBlox
At the moment, the top of the WorkBlox will show the WorkBlox configuration file that is 
currently in use. This is “Start WorkBlox.wtx”.
So, to create a new WorkBlox, simply click on the File menu and select New WorkBlox. You 
should now have a completely blank screen.

The WorkBlox storage of data is a very simple concept. Any top-level tabs are directories. 
The sub tabs beneath these are files, containing the objects for that sub-tab.



So, when you create a WorkBlox you should straight away save the configuration file in a 
new directory and have all the main tabs as subdirectories beneath this.

So, select File|Save WorkBlox As and choose a directory and enter Reviewer’s Guide as 
the name.

Now, we can create some tabs.

So, click on File | New Tab or press the  button on the toolbar. You will be presented 
with:

Type in Start! for the tab name. You can choose a tab color, tab font and the page color for 
the background.
Returning to your WorkBlox page, you will see the new Start! tab appear.
Repeat this process and create a main tab for Blox and also one for Other Work.

Now, we can drop data directly into any of these tabs. However, we may want to sub-divide 

our work again, so click on the Blox tab and then select File | New Sub Tab or press the  
button.
You will see:

We will use Custom, but of course the other options are useful if you want to create a row of 
weekdays for example.
You will now see the standard new tab dialog window. Create three new subtabs, one for 
Note, one for List and one for Calc. You should end up with your WorkBlox looking like:



note: If you go to the Windows 95 explorer and open up the directory that you saved your 
WorkBlox configuration (Reviewer’s Guide.wtx) in, you will see:

You can see from this how the WorkBlox stores its data.

Using the WorkBlox
Now we can start to put some data into the WorkBlox. The first thing that we shall do is place 
some Blox into the WorkBlox.
Try this:
Click on the Note tab inside the Blox main tab and drag in a NoteBlox from the ToolBlox. You 
can position this anywhere inside the Note tab on the page. When you release the button, 
you will see a NoteBlox appear on the page.
Now, click and drag a List off the ToolBlox and drag and hold it on the List tab inside the 
WorkBlox. After a moment the List tab will be selected and you can now drag and drop the 
List into this tab. You can use this functionality to move data from one tab to another.
Try dragging other Blox into the relevant sections and copy them by holding CTRL down and 
move them between tabs by holding them over the relevant tab and then place it in the 
relevant position on the page.



Moving files to the WorkBlox
As you can see we have dragged and created new Blox or objects in the WorkBlox and 
these are stored as part of your WorkBlox data. But suppose you already have files on your 
hard disk that you want to use. You don’t want to embed these in WorkBlox because you will 
have made a copy of the data. However, we can easily achieve the desired result because 
WorkBlox works in conjunction with Explorer to achieve this.

Try this:
Load Explorer from the ToolBlox and choose a file that is an OLE 2 server object type. For 
example drag a Word or Excel file onto the Other Work tab or a file of your choice (note: you 
can drag any file in but only OLE files will draw their actual contents).
You will notice that when you drag from the Explorer the file is “linked” by default. You can 
see this because the mouse has a little shortcut arrow attached to it. This means that all 
WorkBlox stores is a pointer to the file, but it also lets you view the contents of the file 
visually. You can tell that the file is linked because there will be a dotted line around the 
object - e.g.:

Here you can see a Word file dropped into WorkBlox has been linked, but you can still see 
the file details instead of just a file name. If you want to view and edit the document, just 
double click on it.

Miniatures
WorkBlox has a unique and novel feature called miniatures. This allows easy sizing of OLE 
objects. The reason for this is that all objects have a default size when first dragged or 
inserted somewhere. It happens that a Word file object, for example, fills a WorkBlox page by 
its default size, which is no good when you want to place several files in one tab. So, 
WorkBlox shows the object as a miniature. If you want to change the size, click the right 
mouse button on the Object and select Set Miniature Scale and then choose 10,20,50 % or a 
custom value.
Also if you want to set the default miniature scale, select Blox|Options and change the default 
miniature size.

The Virtual Page
Normally, you can pull objects directly onto the WorkBlox page and if you need more room, 
you can scroll the page to the right and downwards to add more objects. However, there is 



also functionality to view the whole page as a virtual page thus allowing all objects to be 
viewed.

To do this, use Blox | View-> Fit to window, or just press the  button.
For example, here is a WorkBlox with several objects in, and then the same WorkBlox with fit 
to window on.

Fit to window:

Arranging Objects

If you want to arrange objects on the page, just select Blox | Arrange, or press the  
button.
If you want to change the spacing, select Blox | Options and then the Layout tab. From here 
you can set the horizontal and vertical spacing between objects and the offset from the top 
left hand corner of the page that the objects start from.

If you always want to arrange objects, select Blox | Auto Arrange or press the  button.



Advanced note:
You may have noticed that when you create New top level tabs, there is an advanced button 
on the new tab dialog window. If you press this, you will see:

This shows you where the tab directory will be created. You will not normally use this feature 
unless:
a) You want to point a tab to a different directory from the place where the WorkBlox 
configuration is stored - for example a network drive.
b) You wish to change relative storage of the directories. By default all main tabs you create 
are placed beneath the directory containing your WorkBlox configuration. If the Save 
directory relative to configuration file is checked, you can move the configuration file and 
all its subdirectories to a different location and still use the WorkBlox. That is - the actual 
directory path is not hard coded, it is all based from the configuration file. However, you 
would not check this box if you wanted to point to a network drive because this is constant 
and is not relative to where you place all the other tabs.


